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Preface: Welcome to Yep
Yep helps you see, create, organize and find your documents. Think of documents as 
the files that you care about.

To get started with Yep, simply launch it. Yep will automatically start tracking all the PDF,  
Office and iWork documents in your Documents, Desktop and Downloads folder on your 
computer. You don’t have to move the documents you want to manage anywhere - Yep 
can manage documents in any location on your computer. 

See documents
Yep shows your documents in a view not unlike iPhoto - this allows you to pick out 
documents using visual cues like the layout or color, 
etc. Yep also has a list view. You change view 
modes with the three buttons in the toolbar.

 You can sort the items by many criteria 
including name, modification date, etc. The middle 
button ‘grouped view’ shows items organized into 
groups based on the sorting you choose.

Create documents
Yep has a great scanner interface that allows you to make multipage PDFs from your 
paper documents in as few clicks as possible. Want to create a quick note with some 

selected text from a web 
page? Just drag it into Yep - 
a file containing any dragged 
text and images is 
automatically created, named 
and filed, all without typing 
anything in one step. Yep can 
create image files from 
dragged in images, and you 
can copy important emails 
from Apple’s Mail program 
into Yep with a simple drag. 

Organize documents
When you file a paper document into a filing cabinet, there is always the question of 
‘where do I file it’? Many documents have more than one good place to be filed to - 



should that waterproof tent idea I wrote a note on be filed under ‘ideas’? or under Sept 
2009? or under ‘camping’?. The advent of computers has been a great boon to finding 

‘stuff’ - but unfortunately the ‘filing cabinet’ paradigm 
still exists on our computers. Yep breaks through that 
with the use of tags - when you tag a document, the 
actual location of it becomes less important. 
Searches in Yep or in the Finder for the term ‘camping’ 
will show this document. Plus Yep shows a ‘tag cloud’ 
which allows you to quickly pick out groups of related 
documents. 

Yep includes an filing cabinet that automatically files 
documents you create in a simple date based 
hierarchy. 

Yep stores no database, and all items in Yep are 
simply real files residing on your computer, available 

and searchable with the Finder. One goal of Yep was to not impose restrictions on 
moving or editing files - Yep tracks them wherever they lay.   

Filed Documents
The Filed Documents folder is a ‘catch all’ folder that Yep creates in your Documents 
folder. It is organized by Year/Month/day and stores documents that have been auto 
filed. 
The modern workday for many of us is an avalanche of information - emails, 
documents, web pages and more fly through our lives. Much of the information that we 
would perhaps like to save does not get saved, usually due to fact that the act of saving 
a document, then deciding a name and filing location for it, dragging the file to that 
location, etc - is just too much of a disruption to our work flow. So it does not get done. 
That’s where Filed Documents comes in. You can, with one or two clicks and no typing 
archive a web page into Yep’s Filed Documents folder. Or drag a file into Yep from your 
desktop, to file it into today’s Filed Documents folder. This strategy allows you to keep a 
time oriented archive of your activity, with tagging and allowing like documents to be 
grouped together. Drag a text snippet from a web page (or anywhere) into Yep to 
create an automatically named text file filed under today. 

Find and Search
Yep allows rapid point and click searching, content searching and more. You can create 
bookmarks for often performed searches. You can organize 
bookmarks. Dragging files to bookmarks will move and or add tags to 
the documents. The search window is at the near the top of the main 
window, in the ‘crumb trail’ bar. The crumb trail bar shows you at a 
glance exactly what documents you are currently viewing. The search 
window can be used to perform ‘all’ or contents searching, or it can be limited to a 
filename search.



Chapter 1: Initial setup
If you are new to Yep, on startup you will see all the  the PDF, Office and 
iWork documents, along with any tagged or starred documents in the 
main Yep window. 
By default, Yep will automatically keep track of any files it finds in your 
Documents, Downloads, and Desktop folders that are PDF, Office, or 
iWork files. You can also drag files of any type into Yep in order to have 
Yep track and manage them. 
Remember that adding a file to Yep does not move or duplicate in any 
way. Yep will simply keep track of it. 
You can change these settings in the preferences:
Once imported into Yep a document stays in Yep until you explicitly 
remove it. Removing it from Yep does not destroy the document. You can 
if you like trash files within Yep, though. Trashing a file moves it into the 
‘real’ trash, just like the Finder.

Upgrading from Yep 2:
Yep stores information about documents in the same way in Yep 2 as Yep 
3. Nothing needs to be done to move from Yep 2 to Yep 3. 
If you have a large collection of files in Yep 1 (which is an older version of 
the application), then Yep 3 will upgrade that collection for you. Also 
please feel free to contact support if you are moving a large collection of 
tagged files from Yep 1 into Yep 3.

 



Chapter 2: See documents
This chapter details all the ways in which you can view, open and get information about 
documents. 

Documents View
The main document view in Yep shows the results of the 
current search. Documents are sorted with the sort menu, 
and can be viewed in three ways:

• as thumbnails - with tags and ratings shown below each item. You can set ratings on 
your documents by simply dragging some stars under a document. 

• as grouped thumbnails - documents are grouped according to the sort method. For 
instance when sorted by file size, files are added to a handful of groups

 

• as a list view - columns can be turned on 
and off in the column header. Note that the 
columns that you have turned on here also 



affects the columns in both the printing and exporting of search results.

Info Windows

Yep has a button  in the toolbar that turns on and off an info area on the right side 
of the main window. With this on, each item you select will display some information 
about itself. If you select multiple items in Yep, you are able to add tags to all of them at 
once using this info panel. 

You can also bring up a floating info window that does NOT change documents when 
clicked on by using the right - click contextual pop up menu. 

The ‘Copy to Clipboard’ item in the info window will copy much more information than is 
shown - use this to dig into the details of a file. 

Loupe - Magnifying glass

In Yep this  is referred to as the Loupe, it is a tool that you can use to examine 
details of files. In Yep’s preferences you can find some options that control its use. By 
default, you can bring up the loupe by holding down the option key. When Yep is 
showing list view, the loupe shows the entire document, which can be nicer than 
bringing up Quick Look for each file you might be interested in. 



QuickLook
By selecting one or more items in Yep, then pressing the space bar, you can bring up 
the Quick Look window for the selected document. This is the standard Quick Look 
window, having full screen mode, and more. 

Right-click menu
When you right click on a document, Yep shows you a 
menu of things you might like to do:
Open With: pick an application to open the file. 
Add Tag: add a recently used tag
Add Tags From Bookmark: If any of your bookmarks 
have multiple tags, you can use this to add them all at 
once.

Show Time Machine Revisions: Yep will look through 
your time machine backups for all revisions of the selected 
document. This is useful to look for an older version of a 
document you have been editing. If you use a Time 
Capsule, you will need to mount the sparse bundle first. 

Remove from Yep: Simply marks the file as ‘not 
managed’ and does not remove or even move the file. 

Where Froms: Items downloaded from the internet using 
Safari will often have a ‘Where From’ set on them that is a URL of the items origin. You 
can open any URLs with this menu. 

Opening
To open a document in Yep, double click it. This will launch the default application to 
open the file. If you would like to set a different application to open a certain file type, 
then use the ‘Open With >” item from the right click menu once. Yep remembers this 
and uses your chosen application the next time you double click. 

You can also of course drag a document to the dock in order to open an item with the 
selected application.  

Printing
There are two things to print in Yep. Perhaps the most common thing to print is a 
document or group of documents. 

Printing a document
You can quickly print a document by selecting it and using the ‘Command - P’ key 
sequence, or by using the File menu | Print Selected. This prints the document by 



launching the default application for the document, and then printing right away, without 
any print dialog. To get more control, open the document by double clicking it, then print 
from whatever application you are using. 

Printing search results
Sometimes you may desire a print out of a listing of Yep’s current search results. Yep 
does this using an html table - Yep prints a list of the documents in the current search, 
with columns given by those that are currently active in list mode.  



Chapter 3: Create documents
This chapter details all the ways in which you can scan and create documents . 

Scanning
Getting to a paperless or even a ‘less paperless’ office in today’s world often involves 
scanning. There are two main ways to scan documents into Yep - using your scanners 
software to create files, or using Yep’s scanning interface to create PDFs. 

Scanning using Yep
Yep has a scanning system tuned for document management. When using a scanner 
with Yep, settings are such that the resulting scanned document is of a high quality and 
reasonable file size. To use Yep to scan with your scanner, make sure all scanner 
software has been installed, and your scanner turned on, etc, then press the 

 Scan New Document button. Yep brings up its scanner interface. If 
you have more than one scanner, or a scanner with more than one input option, use the 
menu to pick which scanner you would like to use, then pick the paper size you are 
using. For flatbed scanners, picking ‘All’ will scan the entire flatbed. 

With the paper in the scanner press the ‘Scan Page’ button. 
Note that with a sheet fed scanner, you only have to press the ‘Scan Page’ button once, 

all the pages in the hopper will be scanned. Duplex scanning is supported if the scanner 
has that feature. 

As soon as the scanner begins to scan, you can start tagging, naming, and adding 
notes about your scan - saving you valuable time. 



You can use the crop, straighten and contrast buttons to improve the look of any page of 
your scans. 

If you are working on a large scanning job and you are called away from your computer, 
forgetting to complete the scan, perhaps even quitting Yep, the next time you start to 
scan any scans not made into a PDF will still be in the Scanning window, ready to 
continue. You can erase all pages of a current scan by clicking the ‘Cancel’ button at the 
bottom of the window. 

Scanning using external scanning software
If you would like to scan using software other than Yep, it is still quite easy for you to 
integrate your scans into Yep. A few possible workflows:

• set up your scanning software to create PDFs (or jpegs, etc) and dump them into the 
root of the Filed Documents folder. When you switch over to Yep, Yep will 
automatically file the documents into todays folder and mark the files as managed, 
leaving you to add any desired tags, etc. 

• after creating a document with your scanner software, drag the resulting document 
into Yep to have Yep keep track of it. 

• use Preview to scan photos into jpeg or tiff images. Yep’s built in scanning creates 300 
dpi multipage PDF documents. 

• the popular ScanSnap line of scanners do not provide scanner drivers, so you must 
use their software. This is a ‘good thing’ - the software provided creates a PDF that 
has OCR applied, and this PDF can be imported into Yep after each scan.

Dragging in text and images
If you drag text from a web page into the Finder, a kind of document called a ‘text 
clipping’ is created. While these documents have their uses, they have limitations. When 
you drag text into Yep (or into Yep’s dropzone), a more standard rtf or rtfd file is created 
with the contents of your drag, auto named, and put into today’s Filed Documents. If you 
drag an image in, the image is saved to today’s documents with the correct file name. 

Dragging in urls (web links)
Dragging a link to a web page, etc into Yep will result in a webloc file being created in 
today’s folder. You can use this to create a daily trail of interesting sites visited. 

Dragging in emails 
When dragging an email from Apple’s Mail.app into Yep, Yep makes a copy of the email 
in today’s files, and names the file to reflect the subject of the email. The thought here is 
that important emails can be added to your collection of files. I find that although I 
‘keep’ all email it seems that emails older than a few years are simply not available, due 
to email account changes, etc. Keeping an archive of important emails can be useful. 



Dragging in files
When you drag in files to Yep, if the files are not already in Yep, Yep offers to add the 
files, or move the files to today’s folder in Filed Documents, (which also marks the files 
as managed, adding it to Yep). If you drag a file that is already managed into Yep, Yep 
simply selects the file. If you drag in a file from a read only volume like a CD-ROM, etc, 
then Yep will have to copy the file to today’s documents in order to make it managed. 



Chapter 4: Organize
This chapter details how you can use Yep to tag and file your documents. 

Adding Tags

Tags window
If you select a document and press the ‘enter’ key a tag entry window appears, allowing 
you to enter tags for the document. Tags are short descriptive words about documents. 

By spending a few seconds tagging a document, you enable 
easier retrieval at a later date. There is a list of recent tags 
you can access with a button at the bottom of the tagging 
area. The recent tags list begins with the tags that are entered 
into the preferences, ‘General’ tab. 

You can also set a 1 - 5 star rating with this window. 

Two word tags
When typing tags in Yep, pressing the spacebar takes you on 
to the next tag. You type two word tags in one of two ways: 

You can put them in quotes, ie “two words” or you can type 
%20 instead of a space. Eg: two%20words will become a two word tag ‘two words’. 

Other ways to add tags
You can drag a document up to the bookmarks bar: If a bookmark has 
tags set you can add them by dropping the file onto the bookmark. 
Note that if the bookmark has a location the document will also be 
moved to that location. When you drag to a bookmark, Yep tells you 
what it will do. 

You can drag a document to the right side of the bookmarks bar, 
where there are some bookmarks in a menu 
called ‘Tag’. This is a list of all the recent 
tagging operations that you have done, so you can save time 
by dragging to this menu, and then picking the group of tags 
that you would like to add. This can be a real time saver for 
repetitive tasks. You drag to the top of the menu then pick the 

tags you want to add.  



Adding tags to multiple documents
You can select more than one document in Yep, then press the 
enter key to add tags to multiple documents at once. 
When multiple files are selected, only tags common to all 
documents are edited. So this is primarily for adding tags.

Removing all tags from multiple 
documents
If you select multiple documents, and want to remove all the tags on 
them, then use the info window, and then press the ‘Remove Unique 
Tags” button. Yep will confirm your decision, then remove all the 
various tags from all the selected documents. 

Deleting a tag
If there is a certain tag that you want to remove 
from any document it might be in, then in the 
‘tag cloud’ panel, right click on the tag and pick 
‘Delete…’ from the menu. Yep will confirm your 
actions, then delete the tag from all documents 
it can find that have that tag. Note that the tag 
may exist on files on other currently unmounted 
volumes. When deleting a tag from a lot of documents (like 100 or more), Yep will finish 
the job in a reasonable time, but it may take a while for the Spotlight database to catch 
up, during which time searches for the tag may give false positive results. 

Filing
The standard OS X save as dialog is slow, and often interferes with the flow of your 
work. With Yep you can file things quickly and efficiently. Here are some tips:

Drag to a bookmark to file a document to that location. Not all bookmarks have suitable 
locations, only bookmarks with locations will light up when you drag over them. Use the 
option key to copy the file to the destination location. 

Drag to the ‘File’ bookmark menu to access recently used destination folders. 

Use the contextual pop - up menu to file a document to an arbitrary location. This will 
bring up the ‘slow’ folder picker - but remember the ‘File’ bookmark will then have that 
location in it. 

Organize your files without using Yep, but rather using the Finder, Path Finder, etc. Yep 
can manage files in any location. Move them around using any way possible.

Move a file to today’s Filed Documents folder by using the button in the info window, or 
the right click menu. 



In the Finder, drag the Filed Documents folder to the documents section of the dock: 
then simply drag any file you want filed to today into there, whether Yep is running or 
not. 

If Yep is running, but you are in another application, like Preview, TexEdit, etc, you can 
drag the little icon at the top of the document into Yep’s dropzone. 

eg: drag the little icon as shown here:  

over to the drop zone. You can also choose to tag the document if you wish. 

The Drop Zone
When Yep is running there is a small window that is turned on by default 
(see the preferences for options) that allows you to add documents to Yep 
easily. The drop zone has 3 zones - you can ‘File’ which puts the 
document into today’s files, you can ‘Tag’ - which tags the file and marks it 
managed, leaving it in place, or you can simply ‘Add’ the file to Yep, 
leaving it in place. 

You can adjust the position of the window in the preferences. It shows itelf 
when the preferences are opened, so you can drag it.

Bookmarks
Bookmarks are saved searches. Yep has some built in bookmarks that 

can’t be deleted, plus you can 
add your own. Bookmarks can be 
organized into folders (including the built in 
ones). 

Organize bookmarks with the little button at 
the left of the bookmark bar:

You create bookmark folders in the 
Bookmark menu in the main menu. If there are some built in bookmarks that you don’t 
need but are using up room, relocate them to a folder. 



Chapter 5: Find
The ‘crumb trail’ bar in Yep always shows the current search criteria, and how many files 
are in the current search results, etc. 

First - an example step by step search: 

The default search in Yep is the ‘All Preferred Places’ search - upon startup Yep will 
simply show all files in the Documents, Downloads and Desktop folders. Looking at the 
above crumb trail, Yep is showing files of ‘Any’ type in ‘All Preferred Places’ with any 
rating. 

If you would like to narrow down your search to for instance only show 
PDF files, you can use the file type menu to pick PDF: In this case I 
have about 2000 PDFs that will be shown. 

 

Next I decide that I only want to see the 2009 PDFs from my filed 
documents - down to 255 documents:

Then looking at the tag cloud - I see the tag ‘receipt’ - click on that to cut the search to 3

That search took about 5 mouse clicks and no typing, finding the document was easy 
once I could see it. 



Default search
Yep does a default search on startup and whenever you hit the ‘home’ button. You can 
set the default search with the Search menu - ‘Set Current Search as Default’ menu 
item.  There is also a way to reset the default search to the original, factory fresh 
settings.

Tag Cloud
The tag cloud shows all the tags set on documents in the current search results, so the 
contents of this window change to show you the most popular tags of the current 
search. If you know the name of a tag, even the first letter, typing it into the tag filter can 
help you find it. 
The ‘All tags’ window shows all the tags - ones that are not involved in the current 
search are shown as dimmed. Using this window you can delete and find harder to find 
tags.  

Tags vs Keywords
There are two little icons at the bottom of the tags window. (If you can’t see this area 
use the View menu - ‘Show Action Bar’). The one on 
the left controls the display of tags - the tags that you 
have set on your documents, while pressing the 
keywords button turns on keywords, displaying 
keywords found inside documents. Keywords are what 
Yep calls tags that have been set perhaps by the 
original author of the document. A good example of a file having keywords is an jpg 
image downloaded from a stock photo service. Images like this will often have 20 or 
more keywords set on them describing the document. Turning on keywords thus opens 
up more information about the documents you are looking at, but the keywords set on a 
file can not be edited by Yep. Usually you will need to use a document editor that has 
this capability. For PDFs, keywords can be edited with Preview. 
We have found the use of keywords to be useful in some situations, and not others. 
Some documents have many keywords set on them of dubious value. 



Chapter 6: Backup and other Details
backing up data and other details like restore, export. 

Backing up data
Yep does not backup any of your documents. You need to run Time Machine, or a 
similar product to back up all your files. My experience over the past 20 years has been 
that hard drives and or computers suffer massive failures every few years (or sooner!). If 
you don’t backup your documents, they won’t be around for long. Sort of like the sign I 
saw at the dentists once: “You don’t have to floss all your teeth, just the ones you want 
to keep”.

Backing up tags and ratings
Yep does make backup files for every item you tag as you tag them. Please note that 
this only happens if the ‘OpenMeta’ application support folder is installed.  This 
allows Yep to restore tags and ratings to files that have had them stripped off, which can 
happen when editing files with Adobe CS4 and a smattering of other applications. These 
backup files are stored in ~/Library/Application Support/OpenMeta (not the Yep folder, 
as all OpenMeta applications use the same system). You can add this folder, or have a 
system administrator do it for you, if you are tagging CS4 files, etc.

Backing up tags and ratings manually
The backup files that Yep makes do form an effective backup, - but there are ways in 
which these files may be incomplete, such as when a tag is added by another 
application that doesn’t make backup files. Also if you are about to reformat a hard 
drive, or other drastic step, then you may want to backup your tags to a single file. To do 
this run Yep, then from the File menu pick “Backup metadata”. A dialog explaining the 

process will come up, and later, when the file is 
made, a dialog similar to the one shown above will 
be shown. 

Restoring from backup
Yep supports restoring from the above two 
methods of backup, plus it also supports the 

importing of metadata from old Yep 1 or Leap 1 
data files. To do any of these operations, pick “Restore Metadata…” from the File menu, 
then in order to tell Yep which kind of backup to do, pick one of:
• a ‘.omsback’ file that you made in an earlier manual backup,
• a docInfo.plist.gz file from an old Yep 1 or Leap 1 install or
• the OpenMeta folder in your Application Support folder. 

In all three cases Yep will restore tags and ratings to any file it can find in the backup 
file, being careful not to overwrite newer tags with older ones. Yep stores the path and 
an alias to the files it makes backups for, and it tries to find the file to restore to using 
both these methods. Yep will also finish a restore operation with a dialog informing you 
of the results. If Yep has to set tags on documents that you need to authorize with a 



password in order to modify, a dialog will be presented for that. This security 
authorization for Yep to alter files only lasts a few minutes, so there may be a few of 
these if there are a lot of files in system areas that you are tracking. 

Tech support
At ironic we offer email tech support for all our products. It may be faster to check out 
the discussion forums first. Our tech support page is located on our web site, at http://
www.ironicsoftware.com
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